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Finding Information Fast

PeakNet-PA Software User’s Guide

The PeakNet-PA Software User’s Guide, for PeakNet-PA Software Release
5.21, is a reference guide that provides a complete description of each
feature of PeakNet-PA software. Use this manual when you want details
about a PeakNet-PA program, its menus, dialog boxes, and functions.

On-line Help

PeakNet-PA provides extensive on-line help, which is available from the
MainMenu and from each PeakNet-PA program. Use the Help for quick
access to information about the program or dialog box you are using, and
for step-by-step instructions on tasks you wish to perform.

There are several ways to access the on-line Help:

¢ Click on the Help button in the MainMenu

e Select Index from the Help menu of any PeakNet-PA program
e Press the <F1> function key

For more information about using Help, see Chapter 3.

Release Notes

Any important information that was unavailable when this manual was
printed is contained in the Release Notes of the PeakNet-PA on-line Help.
You can view the release notes automatically at the conclusion of the
PeakNet-PA setup procedure or any time after installation from the
PeakNet-PA Help.

To view the Release Notes:
1. Access the PeakNet-PA Help.
2. Click on the Help Topics button in the PeakNet-PA Help window.

3. Select the Contents tab and select Release Notes.
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1 ¢ About PeakNet-PA

1.1 Overview of PeakNet-PA Workstations

PeakNet-PA workstations are used to control the instruments that make up
the DX-800 Process Analyzer, collect data from the controlled instruments,
process the data, display the data (trend), and generate reports.

A PeakNet-PA workstation consists of an IBM-compatible personal
computer, a DX LAN interface to the controlled instruments, a printer
(optional), and PeakNet-PA software.

Through the DX LAN interface network, PeakNet-PA software can control
and monitor up to eight channels, configured into a maximum of four
analyzers.

A typical channel consists of:

e A CC80 Component Controller

e An analytical pump (1P20, IP25, GP40, or GP50)

e A detector (AD20, AD25, CD20, CD25, ED40, or ED50).

Other instruments, for example the EG40 Eluent Generator, can also be
configured in a channel

Each analyzer consists of:
e An optional SS80 Sample Selection Module
e From one to four channels

NOTE For detailed system requirements, refer to the PeakNet-PA
installation instructions (Document No. 031832).
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1.2 Overview of PeakNet-PA Software

Extension of PeakNet®

PeakNet-PA is an extended version of Dionex PeakNet chromatography
automation software. PeakNet-PA adds sampling of process sample streams,
configuring alarms, and displaying historical data (component trending) to
PeakNet's instrument control and data processing functions.

Family of Programs

PeakNet-PA is a family of programs, each with specific functions. The
PeakNet-PA MainMenu organizes the programs into groups based on their
functions and lets you start the programs from one convenient location.

In addition to the MainMenu programs, PeakNet-PA also incorporates the
Dionex customized Wonderware InTouch® Human-Machine Interface
(HMI). This user interface provides real-time analyzer status, component
alarm configuration and notification, and component trending.

Three-way Program Communication

During operation, three PeakNet-PA programs (Analyze, Run, and InTouch)
establish several communication links, which allow operating instructions,
status information, and sample results to be exchanged between programs.
The Analyze program and InTouch communicate through Dynamic Data
Exchange (DDE). Analyze and Run communicate through OLE, and sample
results are exported to a database that supports ODBC.

Windows Environment

PeakNet-PA runs under Microsoft® Windows NT® and follows the
Windows conventions for menus, dialog boxes, toolbars, and other user
interface features. The PeakNet-PA on-line Help also follows the Windows
conventions.

PeakNet-PA supports the Windows Clipboard for cutting and pasting
information to and from PeakNet-PA and other programs.

If you are unfamiliar with Windows, refer to the Windows documentation
before running PeakNet-PA.

1-2
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1.3 Overview of PeakNet-PA Programs

1.3.1 The PeakNet-PA MainMenu

The MainMenu (MENUDX.EXE) is organized as a
series of “tab pages’ on which each PeakNet-PA
program is represented by a button. Resting the
mouse on a button displays a brief description of the
program’s function; clicking on a button starts the
program.

There are four tab pages:

o A PeakNet-PA tab page for the main PeakNet-PA programs

e An Accessories tab page for PeakNet-PA accessory programs

e An Options page for modifying default paths, the MainMenu,
and the PEAKNET.LOG file

e An About page that indicates the PeakNet-PA software release

level

1.3.2 Main Programs

o,

[

The Configuration Editor (CONFIGDX.EXE)
assigns the pump, detector, and CC80 modules to
analyzer channel(s). Run the Configuration Editor
during the initial installation of PeakNet-PA software,
as well as each time the instrument configuration
changes.

The Method Editor (METHODDX.EXE) creates
and edits Methods, which tell the modules how to
prepare a sample or standard, inject it, and run an
analysis. Each Method includes a channel
assignment, and operating parameters and sequenced
or timed events for each module in the channel.
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The Analyze program (ANALYZEDX.EXE)
creates and edits analyzer configurations and
Schedules, loads and runs the Schedules, and
monitors analyzer status. An analyzer configuration
assigns channels to the analyzer, assigns sample
names to the SS80 valve positions, specifies the
Method to run, specifies actions to take if an alarm
occurs, and includes other configuration settings. An
analyzer Schedule defines a list of injections to be
run in sequence.

For each configured analyzer, the Analyze program
also provides a Monitor window that displays status
information about the Schedule as it is running.

Starting the Analyze program automatically starts
the Run program and the InTouch interface. Closing
the Analyze program, closes the InTouch interface
and the Run program.

The Optimize program (OPTIMDX.EXE) retrieves
raw data from the disk drive for additional

e processing. The data file is first shown exactly as it
was processed at the time it was saved. Optimize
commands enable you to test various treatments of
the raw data; modify the data; and then update the
Methods, data files, and report files.

;

Optimize lets you visually compare up to 12 stored
chromatograms. These may be plotted on separate
axes or overlaid on a single set of axes. Optimize
also calculates and plots the mathematical sum,
difference, or ratio of any two raw data files
collected and stored by the Run program. Optimize
can plot the first and second derivatives of a data file,
store the calculation results as a new data file, and
process the file just as it would any other data file.
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—

The Batch program (BATCHDX.EXE) reprocesses
previously stored data files in a group, rather than
individually. Using information from Schedules,
Batch retrieves the names of the data files to be
reprocessed and the Methods to be used. Batch then
stores the reprocessed data as new files and generates

new reports.

1.3.3 Accessory Programs

The Report Designer (REPORTDX.EXE) lets you
create and edit custom formats for three types of
single-injection reports: Sample Analysis, Calibration
Update, and Check Standard. The Report Designer also
lets you create formats for summary reports, generated
by the Batch program from multiple data files.

The AIA program converts a PeakNet-PA raw data file
into the AIA data file format (Andi/Chromatography)
for import into a different chromatography data system.
The program also converts a raw data file in the AIA
format into a PeakNet-PA raw datafile. In either case,
the conversion process creates a new file; it does not
change the existing file. Refer to the on-line Help for
details.

The PeakNet-PA event logger automatically records
significant events in the PEAKNET.LOG file, which is
stored in the same folder as the PeakNet-PA programs.
You may review or print the event log, for informational
or troubleshooting purposes, using Windows Notepad or
other text editor.
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The Installation Qualification program uses an error
detecting technique called Cyclic Redundancy Check
(CRC) to verify that all files are installed correctly
during PeakNet-PA setup. The Installation Qualification
program runs automatically after PeakNet-PA setup. It
can also be run at any time from the MainMenu.

The Operational Qualification program checks
PeakNet-PA operation by generating reports and
exported values from reference data files. The exported
values are then compared with reference exported
values.

The Gradient Pump Qualification program tests for
the correct operation of Dionex gradient pumps by
analyzing gradient profile raw data files, created using
example Methods supplied by Dionex. The program
performs a series of tests to determine whether the
pump is operating within specified performance limits.

1-6
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1.3.4 Options Page

The Options page lets you specify default paths for data, Method,
and Schedule files, as well as define the behavior of the MainMenu,
and configure the event log.

PeakMNet MainMenu M= E3

F'eakNet-F'.t’-‘«I Bccessores  Options |.~’-‘n.bl:|ut I

Browse... |

— Default Paths
Item:

FeakMet Data
Fath:
c:hpeaknetidata

— Maintdenu

V¥ Minimize after Program Launch
¥ Dizable Startup Bitmap

Ewent Log
¥ BunEvents and Emors [ File Saves

M aximum Size: |1EIEI KBytes or [ Mo Limit

Sawe Seftings |
Help |

Use the Default Paths Item drop-down list to define where files are
saved for all systems. You can specify a different path for each type
of file (PeakNet data, Methods, and Schedules). Clicking Browse
lets you select an existing folder, but not create one. To select a new
folder, first create the folder in Windows Explorer or My Computer.

In the MainMenu box, selecting the Minimize after Program
Launch check box automatically minimizes the MainMenu when it
starts any program. Selecting the Disable Startup Bitmap check
box prevents the PeakNet-PA logo from being displayed when you
initially open the MainMenu program.

For details about configuring the event log (the file in which
PeakNet-PA records significant operating events), see Section 3.3.
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1.4 Other PeakNet-PA Programs

The Run program (RUNDX.EXE) accepts instructions from the Analyze
program to load and run an analyzer Schedule. Run is only available when
the Analyze program is open; it is not used separately. While running, Run
displays each channel’s status and real-time plot in system windows, which
you can view by double-clicking on the channel’s picture in the InTouch
Analyzer Status screen.

When an analysis is complete, Run directs the computer to save the raw
data. Run then detects and integrates peaks, calculates component
concentrations, based on response factors calculated from calibration
standards, and communicates the results to the InTouch interface using
ODBC (Open-Database Connectivity).

Run can also be used for direct control of modules.

The Schedule Editor (SCHEDDX.EXE) creates and edits Schedules that
the Batch program uses when reprocessing groups of previously stored data
files. These Schedules specify alist of data files and the Method to use to
reprocess each file.

NOTE Schedule files created with the Schedule Editor program are used only
for Batch processing. These files are given a .SCH extension. Schedule
files created in the Analyze program are used to control the sequence
of injections run by the analyzer. These files are given a . ANS
extension.
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2.1 Starting PeakNet-PA Programs

e To start the MainMenu, select the Start button on the Windows taskbar,
select Programs, Dionex Programs, and then PeakNet-PA.

NOTE To have the MainMenu start automatically when Windows
starts, select the corresponding option during PeakNet-PA
Setup.

PeakMet MainMenu M= E3 |

FeakMet-Pa |.-'l'-.|:|:essu:|ries| Options | About |

2 42

Configure b ethod

e

l\(

Analyze

i =

Optimize Batch

Help |

e To start a main or accessory program, select the PeakNet-PA or
Accessories tab on the MainMenu, and click on the button that
represents that program.

e To start the InTouch interface, click on the Analyze button on the
PeakNet-PA MainMenu. This starts the Analyze program, the Run
program, and the InTouch interface.
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2.2 The InTouch Interface

The Analyzer Status screen appears when InTouch starts. From this screen
you can:

e View analyzer status
e Access other InTouch screens
e Access other PeakNet-PA programs

e Control analyzer runs

FeakNet-PA

Analyzer Status
Clickona
channel to
view its
Run
program
Click on a status
sample window
name to go
to its
Sample
E:rzlélrt]s Select the
analyzer to
view
Analyzerd
=17
Go to the Control Go to the Go to the View
Analyze analyzer Alarm Scheduled  on-line
program runs Configuration Report Help

screen screen
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2.3 Overview of PeakNet-PA Operation

The figure below illustrates the PeakNet-PA setup and operation sequence.
The sections following the figure provide examples for each operation step.

Configure Systems

(Channels)

¥

Create Method(s)

£ 2

Configure Analyzer

¥

Run Manual
Sample to Test

|—>

Optimize

Method

Default Method

LYes I

Modify
Method?

No

Create Analyzer
Schedule

¥

Analyze Samples

¥

View Trend Data

¥

Report Results
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2.3.1 Configuring Channels

PeakNet-PA and the modules in each analyzer channel. Once
configured, you will not need to reconfigure PeakNet-PA, unless the
system changes.

w The Configuration Editor establishes communication between

NOTE In the Configuration Editor, a system is equivalent to a channel.

Example: Configuring a New System (Channel)

This example configures a new system that includes a CC80
Component Controller, a CD20 Conductivity Detector, and a GP40
Gradient Pump.

NOTE When you first start PeakNet-PA, if no system configuration
information is found, a message box appears; select OK to
start the Configuration Editor and display the Create New
Systems dialog box.

1. If necessary, open the Configuration Editor by clicking on its
button in the MainMenu.

2. Select Systems from the Configure menu.
The Edit Systems dialog box appears

3. Click on the New System button.
The Create New Systems dialog box appears.

4. Enter a system name. In this example, Channel 1 is entered.

Edit Syztems B3 |

Suztems: IIhazsioned Modules:
Create New Syztem Ed |

Lem... |

M arne of Mew Sypstem: |LI ﬁl
_Cored |

IEhanneI 1|

Cancel

Itﬁd CCAm: —l
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5. Select OK.

If there are no other systems configured, a message box appears
asking whether you want to assign all the on-line modules to
the system. You can select Yesif the on-line modules consist of
only one CC80, one detector, and one pump. This automatically
assigns these modules to the new system and opens a system
window (see the example in Step 9).

If you select No in the message box, or if the message does not
appear, you are returned to the Edit Systems dialog box. The
Systems list now shows Channel 1.

Edit Systems |

Unazsigned Modules:

Systems:

D LAM 1D: 00 05 AC
CO20:

D LAN ID: 0005 AD
GP40;

D LAM 1D: 0005 A8
CCaL:

Mew Sustem. ..

Azzign Module

il

E xit

To assign the CC80 module to the new channel, highlight it in
the Unassigned Modules list.

Click on the Assign Module button.

Repeat Steps 6 and 7 for the detector and pump modules (and
eluent generator if present). Note: A channel must contain at
least a CC80 and a detector module.

If there are no other modules on-line, a message informs you
that all modules have been assigned. Click OK to close the
message. Otherwise, click Exit to close the Edit Systems dialog

box.

A system window for the channel appears.

Doc. 031322-02 2/02

2-5



PeakNet-PA Software

[ PeakNet Complete Control Configuration Editor

File Configure  View *Window Help

=EREEEEA

& Channel 1

21 DX LAN ID: 00 05 AD
g GP40:

I"‘il Dx LAN ID: 00 05 AC
8| cD20:

DX LAN ID: 0005 AB

- [0] x|

Ready

[ .

10.

11.

12.

Select Database Export Options from the File menu to open the
Database Export Options dialog box.

Select each system name and confirm that the following settings
are selected:

Peak Table: All Components

Insert Mode: Overwrite

Sample Type: Select all check boxes.

Table Selection: Select all check boxes, except CE Result.

For details about the Database Export Options, see Section 5.3.2.

Save the new system configuration by selecting Save from the
File menu.

Exit the Configuration Editor.

2-6
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2.3.2

2

Creating Methods

Use the Method Editor to create Methods and Sample Preparation
files, which tell the modules how to prepare a sample (or standard),
inject it, and run an analysis. Each channel is assigned a default
Method file, which provides operating parameters and sequenced or
timed events for the analysis. Additional Sample Preparation files
are also defined and assigned to each channel to provide alternate
preparation steps for standards, and if desired, individual samples.

PeakNet-PA provides example Methods for each type of application
(concentration, dilution, etc.). In addition, there are Sample
Preparation files for specialized functions, including preparation of
calibration standards, alternate sample preparation, and standby
Methods. These are copied to the peaknet\methods\example folder
during setup.

Example: Creating a Method

This example creates a new Method for the channel configured in
the previous section.

1. To open the Method Editor, click on the Method Editor button
in the MainMenu.

2. Select New from the File menu to begin creating the Method.

The Configuration dialog box appears. This dialog box lets you
select for which system (channel) the Method will be used, and
which of the channel’s assigned modules will be included in the
Method definition.
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N |

Syztem fethod Type

Svsterm 1 Channel 1 |I|:|n Chromatography j E it I
Unazsigned Modules ethod Configuration

Add xr |
Eemnvel

3. From the System drop-down list, select Channel 1, and also
verify that the selected Method Type is lon Chromatography.

4. In the Unassigned Modules list, the three modules configured
for Channel 1 are highlighted. Click on the Add>> button to add
the modules to the Method Configuration.

5. Click on Exit to close the dialog box.

A window for the new Method appears. From this window you
can define the parameters for sample preparation and data
acquisition. This is done by defining parameters for each
modul e separately.

¥ Method Editor - Method1
File Edit ¥iew MWindow Help

Dizldl gl m=] 2 6 2] B

Ef Methodi
Module: Data Collection—————— —Flot Scales

Time: Eate: kdaximum:

' [eo0 Hwin [soomz =] | [0 us

kdinirnurm:

Detector Units: IpS j I -1 ps

Data Processing —e Data
|7 R e

Selecta module to edit
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Defining CC80 Method Parameters

1. The CC80 Preparation Steps dialog box lets you define the

sequence of functions to be performed by the SP80 Sample
Preparation panel and the LC80 Liquid Chromatography panel.

To open this dialog box, highlight the CC80 module in the
Method Editor Module list and then click on the Events button,
or double-click on the CC80 module name in the list. The

dialog box appears; currently no steps are defined for the
Method.

CCB0 Preparation Steps 1]

List of Preparation Steps: Tatal 0O Sehup |
Step : Funchion Parameters =

| E xit |

Eunctioh: I\-"al\-’e Control 'I Inzert Welete I Enter I

Eomment:l

—Sample [SM) Gas [GAS) — Dilution Yessel [OV] - SamplesStd. [S5)
& waste () & went (0] @ purge [0) & sample (0]

© zample (1] " pressurize (1] 55 walve [1) € standard [1]
—Chk. Std. [C5]— - Metering [ME]— — Diluent (1]

& sample (0] " standard [0) @ closed (0)

© chk. std. (1] " diluent (1] " open (1)

NOTE The valves shown and their functions will vary depending on

the type of configuration installed (dilution, concentration,
dilution with reagent, concentration with reagent).

Instead of defining each individual preparation step, this
example shows how to copy steps from an example Method to
the new Method. This is a very convenient way to define new
Methods and Sample Preparation files, but the modules need to
have the same configuration or errors can occur. Be sure that
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the configurations are the same or use the Paste Special
command to copy only the Sample Preparation steps.

2. Select Exit to close the dialog box.

3. From the Method Editor File menu, select Open.

4. Select a Method file from the examples and click on Open.

& Method Editor - example.met
File  Edit “iew ‘wWindow Help

Dl 8| =] 7] & 2

Ji Method1.met 9 =] B3
todule: Data Collection Plaot Scales
- iimes Fiates b &
] - =
= I =i e I j I
T
I—-':-i'i D20 =il example.met =] E3
%ﬁ GP40 —Data Collection———————————— ~Plot Scales
£ iimEs Eate: F & =i
— Events —
= | =i Min-| j |
b i

[Wetestar [hits: I j I

|'Qata Proceszsing —eer Data

Select a module to edit

5. To view the preparation steps for the example Method, highlight
the CC80 icon and click on the Events button. Click on Exit
after viewing the steps.

6. To copy the preparation steps, highlight the CC80 icon in the
example Method window and select Copy from the Edit menu.

7. To paste the steps into the new Method, highlight the CC80 icon
in the new Method (Methodl) window and select Paste from the
Edit menu.
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8. To verify that the steps were copied, click on the Events button.
In this example, the following steps were copied from the
example method:

CCB80 Preparation Steps E

List of Preparation Steps: Total 11 B |
Step : Function Parameters o =
H Exit |

mject

002 “alve Control Sh:1, GaS:0, 00, 55:0, C5:0, ME:Q, DI:0
003w ait for 0.2 minute(z)

004 Pump Control Loading Pump, On

005 wait far 0.2 minute(z)

006 Load / Inject Load

007 Pump Control Loading Pump, 10.0 mL

008 wait urtil Loading Pump iz done
003 Load /Iniect et =
Function: ILc.ad A mject vl Inzert Delete I Enter I

Qomment:l

Load ¢ Inject [LI] ¥alve

" Load
& Inject

9. Change Method steps, if desired, as follows:

e To edit astep, click on the line to highlight it, make the
desired changes; then click on Enter.

e Toinsert a new step, highlight the line below where the new
step should be, and click on Insert. A copy of the
highlighted step is inserted. Edit the step and click on Enter.

e To delete a step, highlight it and click on Delete.
10. Click on Exit to close the dialog box.

11. To print out a report of the Method parameters for a module,
select Print from the File menu. Select the desired module(s), in
this case the CC80, and click on OK.

The following is a printout of the CC80 Method parameters
from the example. Comments describe the purpose of each step
in the list.
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Method Report - Method1

Method Information : Select Module(s)

System Name:

System Number:1

Method Type lon Chromatography
Column:

Analyst:

Comment: (null)

CC80 Timed Events

Column Temperature: Off
Post Column Pump:1

TTL 1 Label: TTL 1
TTL 2 Label: TTL 2
TTL 3 Label: TTL 3
TTL 4 Label: TTL 4
TTL 5 Label: TTL 5
TTL 6 Label: TTL 6
TTL 7 Label: TTL 7
TTL 8 Label: TTL 8

Relay 1 Label: Relay 1
Relay 2 Label: Relay 2

Step Function Parameters

001 Valve Inject

002 Valve SM:1, GAS:0, DV:0, SS:0, CS:0 ME:0, DI:0
003 Wait for 0.2 minute(s)

004 Pump Control Loading Pump, On

005 Wait for 0.2 minute(s)

006 Valve Load

007 Pump Control Loading Pump, 10.0 mL

008 Wait until Loading Pump is done

009 Valve Inject

010 Run Start the pump and detector methods
011 Valve SM:0, GAS:0, DV:0, SS:0, CS:0, ME:0, DI:0

Comment

open sample lines

wait to prime sample lines
turn on loading pump
wait for pump to prime
loading conc column
loading 10 mL

wait for loading pump
inject sample

start pump and detector
return valves

2-12

Doc. 031322-02 2/02



2 e Getting Started

g Defining GP40 Method Parameters

1. To define the GP40 Method parameters, highlight the GP40
module in the Module list and then click on the Events button,
or double-click on the GP40 module.

The GP40 Setup dialog box appears. If an eluent generator is
configured, the GP40 and EG40 Setup dialog box appears. The
setup dialog box sets pump (and EG40 if configured)
parameters that will remain constant throughout the Method.

GP40 and EG40 Setup | x|

— G40

Pump
& 00
 0ff

— Pressure Limits
ﬂigh:ISDDD 3: psi -
Low: lﬂ 5 Cancel |

Ok

Pizton Size:

luent Labels

I Microbore

Pressure Units

bar
MPa

Description:

—E
A
E
[
b

L

—EG40

Offzet Wolume:

Eluent Label:

TTL Output Label: [TTL1

Jaono =

IEIuent Generatar

This example sets the following parameters:

e The pump is turned on at the beginning of the Method and
remains on throughout the Method.

e The High and Low Pressure limits are set to 2700 and 20
psi, respectively. This means that the pump will shut down
if the system pressure goes above 2700 psi or below 20 psi.

e The selected piston size is microbore. This setting must
match the size of piston installed in the GP40.

e An EG40 offset

volume (the loop volume between the pump

outlet and the injection valve) of 400 L.
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2. After entering the setup parameters, click on OK to close the
dialog box.

The GP40 Editor screen then appears. If an eluent generator is
configured, a combination GP40 and EG40 Editor appears. This
screen lets you define a series of timed operating instructions for
controlling pump flow rate, eluent composition, eluent
concentration if an EG40 is configured, and TTL and relay outputs.

NOTE The Inject Output check box is unavailable because the CC80
controlsinjection in a PeakNet-PA Method, not the pump.

+ GP40 Editor
Tirne (Min):

Elaw (L min):

Curye  Comment:

[ mit =]

—Eluents

— Outputs
I~ et
I~ Column
I TTL
CTrL:
I~ Relay1

[~ Relay 2

[o2s =

NI

Exit |

100%: 08

0%

10

Wl ete

Iew

Setup...

HildS

Bl

This example sets a flow rate of 0.25 mL/min in the Init Time step
and in the 0.00 Time step. It does not include any other timed steps,
and default values are used for all other settings.

NOTE The Init time step isin effect after the Method is loaded to the

module and until the start command is sent.

3. To set theinitial flow rate to 0.25 mL/min, highlight the current

value in the Flow (mL/min) box and type 0.25.

4. Click on the Enter button to record the change.

5. To set the flow rate at the start of the Method to 0.25 mL/min,
click on the down arrow in the Time box and select the 0.00

time. Then, enter 0.25 in the Flow box.

2-14
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6. Click on the Enter button to record the change.

7. After defining the pump timed events, click on the Exit button.

8. When asked whether to save changes, select Yes.

Defining CD20 Method Parameters

1. To define the CD20 Method parameters, highlight the CD20
module in the Module list. This enables the Data Collection,
Plot Scales, and Data Processing controls.

¥ Method Editor - Method1
File Edit ¥iew Window Help

[_[O] x|

MEFEIE B EEEEE)

&l Method1
Data

Time:

Caollection

RBate:

—Plot Scales

kdaimurn:

: |1am

::I hdin. |5 00 Hz

=l

[ 10

kinimum

Detector Units: IpS

[ -1

ps

ps

|—Qﬁ1a Processing
z

—&-v Data

Selecta module to edit

[ Mol

This example sets the following parameters:

e The Data Collection Time of 18 min means that data will be

collected for atotal of 18 min.

e The Data Collection Rate of 5.00 Hz, (the default) means
that 5 data points per second will be collected.

e The Detector Units of uS are used for conductivity detection.

e The Maximum and Minimum Plot Scales of 10 and -1 uS,
respectively, set the scale for the Y-axis (the response) for
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real-time plots displayed during a run. These settings do not
affect the data actually collected.

The Data Processing buttons set data smoothing, integration,
calibration, component identification, and reporting options.
Default settings generally work well for a new Method. If
necessary, these settings can be changed using the Optimize
program, after data has been collected.

2. To define a series of timed operating instructions for controlling
the detector, click on the Events button.

The CD20 Editor screen appears.

CD20 Editor E3
Time (Min):  Bange (PS): Collection———— — Dutputs
| = | oo F (I' EEgi I~ Offset
[Time  Range  Offset  Mark TTL/RLY Collect | | = ppark Ll
i [~ TTL1 Helete |
0.00 1000 0000  Begin
010 1000 ooon [~ TTLe
SRS Cell.. |
I~ ALY
I~ RLy2

In this example, data collection will begin at 0.00 min. and the
detector will be offset at 0.10 min.

No changes are required for the Init or 0.00 Time steps.

3. To enable the offset, select the current value in the Time (Min)
box and type 0.010; then click on the Offset check box to
enable the offset at 0.10 min.

4. Click on the Enter button to record the new step.

When the offset occurs, the baseline is set to 0. This offset
value is then subtracted from the detector output during the
remaining data collection time.

5. To set the current for the SRS, click on the SRS/Cell button.
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The CD20 Editor: Cell Settings dialog box appears. In this
example, an SRS current value of 50 mA is selected. Default
Temp. Comp. and Cell Temp. values are used.

CD20 Editor: Cell Settings E
— SRS
0]9 I
Current:  [ERGES
Cancel |
—Cell
Temp. Comp. | 1.7 5 wpc

Cell Temp.: |35 3: s

6. Click on OK to close the dialog box.
7. Inthe CD20 Editor dialog box, click on the Exit button.
8. When aske